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Overview

This subsection discusses the following topics:
• How to locate the latest version of the NS-Link device driver and related

installation documentation.
• Information about NS-Link, such as:

- Installation quick reference for experienced users.
- NS-Link hardware and software requirements.
- Device connectivity requirements.
- IP or MAC addressing issues.
- Overview of port sharing.

How to Use this Document

You can use the interactive Table of Contents to locate the information you need.
Red, underscored items are links to URLs. Blue, underscored items are links
within this document or to another document on the media.
Note: If you copy this document from the ftp/web or CD and do not use the

procedure discussed on the CD, you will get an error message when selecting
hyperlinks outside of this document.

Locating Hardware Installation Documentation

Use the hardware installation documentation to install the hardware before
installing NS-Link. The hardware installation documentation is available on the
Comtrol CD ships with your product or you can download the current version from
the ftp site using the following links.
• DeviceMaster RTS Hardware Installation and Configuration or

ftp://ftp.comtrol.com/Dev_Mstr/RTS/HW_Doc/RTS_Install.pdf.
• RocketPort Serial Hub ia Hardware Installation document or

ftp://ftp.comtrol.com/RPSH_ia/HW_Doc/2000169.pdf).
• RocketPort Serial Hub 2-Port Hardware Installation document or

ftp://ftp.comtrol.com/RPSH_Si/HW_Doc/2_Port/2000153A.pdf.
• RocketPort Serial Hub 4/8-Port Hardware Installation document or

ftp://ftp.comtrol.com/RPSH_Si/HW_Doc/4&8_Port/2000058.pdf.

Locating NS-Link Software and Installation Documentation

You can download the latest NS-Link device driver updates at no charge from the
Comtrol Web site at: http://support.comtrol.com/download.asp. Always check the
Web or ftp sites to make sure that you have the current driver and documentation.
The software files that you download from the web site are self-extracting zipped
files that you must extract before installing.
The Comtrol CD that ships with your product can streamline the installation of
your product. When loaded on a system running a Microsoft operating system, the
CD opens a menu system (unless the autorun feature is disabled).
Note: If the autorun feature has been disabled, open the Readme.pdf file at the

root of CD to start the menu system.
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NS-Link Overview
NS-Link Overview

The following subsections discuss NS-Link features and topics that you may want
to review before installation.

NS-Link Installation
- Quick Reference

If you are familiar with installing Comtrol software, you can use the following
procedure as a quick reference:
1. Install the hardware.
2. Unzip the self-extracting NS-Link files.
3. If necessary, remove the existing NS-Link driver.
4. Install NS-Link and the configure the port characteristics in NS-Link setup.
5. Shut down and restart the server.
6. If necessary, program the IP address into the device.
7. Connect your serial devices.

NS-Link
Requirements

This subsection discusses installing and configuring the NS-Link driver for the
following hardware platforms:
• DeviceMaster™ RTS

Note: Install the NS-Link driver if you want to use the ports as native COM
ports. You can also configure the ports as sockets after the NS-Link
installation.

If you want to configure the port for only socket mode or serial
tunneling, you do not need to install NS-Link. See the DeviceMaster
RTS Installation and Configuration Guide for socket configuration
information.

• RocketPort® Serial Hub ia or RocketPort Serial Hub Si
The NS-Link driver requires at least one host server running Windows® 2000.
Note: The driver for the RocketPort Serial Hub Si is different than the driver

for the RocketPort Serial Hub and they are NOT interchangeable.

Connectivity
Requirements

An ethernet connection, either to an Ethernet hub or to a network interface card
(NIC) in the host server. See the hardware installation documentation (Page 5) for
information regarding hardware installation.
If you are connecting a RocketPort Serial Hub Si or RocketPort Serial Hub ia
directly to the server NIC card, an ethernet crossover cable is required (see the
Hardware Installation documentation).
If you are connecting a DeviceMaster RTS directly to the server NIC card, connect
an ethernet cable to the port labeled DOWN. If connecting a DeviceMaster RTS to
an ethernet hub, connect an ethernet cable to the port labeled UP.

IP or MAC
Addressing Issues

This is an overview of IP and MAC addressing issues that may affect how you
configure the Comtrol device with a brief discussion of advantages of either
method.
The IP addressing scheme has the following advantages:
• Uses an industry standard protocol.
• Allows you to configure servers to use ports on the Comtrol device that are

outside of the host server’s Ethernet segment.
Note: This IP address must be a unique reserved IP address, do not use an
Overview 6



Using the Port Sharing Feature
address from a dynamic address pool. If necessary, see the system
administrator for an IP address.

The MAC addressing method has the following advantages:
• Simplifies implementation and ongoing support by eliminating the address

administration issues inherent in network protocols. MAC addresses are
predefined by Comtrol and there is no potential for an “address conflict” at
setup.

• It is isolated from foreign LAN segments, which minimizes potential security
issues.

Using the Port
Sharing Feature

The Comtrol device can be shared with multiple servers on a network. To do so,
follow the Installing NS-Link discussion for each server that you want to permit
access to the serial ports.
You can implement the port sharing feature in several ways. You can share the
same port with multiple servers or you can set up multiple servers to share
specific ports on the Comtrol device.

Note: Most applications do not release ports, so you may not be able to use port
sharing across multiple servers with the same port. Also, if using port
sharing, make sure that two computers do not try to access the same port at
the same time. Only one computer can control a given port at a given time.

Using SNMP (RPSH-Si 4/8-Port, Only)

To configure SNMP for the RocketPort Serial Hub Si 4/8-port, use the Diagnostic
and IP Configurator utility. This utility is delivered on the Comtrol media shipped
with your product or available on the ftp site at: ftp://ftp.comtrol.com/RPSH_Si/
Diag/4&8_Port/.
The Hardware Installation documentation (also on the Comtrol media) provides
you with information about how to use the Diagnostic and IP Configurator utility.
Note: For SNMP configuration on other models, see the ftp/web site for

availability.

Comtrol Device
Port 1

Server A Server B

Port 2

COM 5 COM 6

Port 3 Port 4

COM 5 COM 6

Ethernet Hub

Configured for Server A Configured for Server B

Example:
To configure two ports for Server A and two ports for Server B,

1. When installing NS-Link on Server A, select “Not Configured” for the

2. When installing NS-Link on Server B, select “Not Configured” for the

COM port names must be unique to each server.
Multiple servers can use the same COM port names.

:

you could configure the drivers like this:

COM port names for Ports 3 and 4.

COM port names for Ports 1 and 2.
Overview 7
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NS-Link Installation and Configuration

Use this subsection to install and configure the NS-Link device driver for the
Windows 2000 operating system.
Note: Make sure that you remove any existing driver before installing a new

version of the driver.
This subsection also discussing the following configuration topics:
• Programming an IP address
• Verifying installation
• Changing device properties
• Changing COM port properties
• Adding additional devices

Removing an Existing Driver

Use the following procedure to remove any existing NS-Link device driver for the
Windows 2000 operating system. If you are updating (and not reconfiguring) the
driver, Technical Support recommends that you remove the existing version before
installing a new driver.
Note: The Remove button on the Comtrol Main Setup window only discards the

software configuration. It does not remove the software.
1. On the Windows desktop, right-click on the My Computer icon and choose

Manage from the shortcut menu.
2. In the Tree panel of the Computer Management window, select Device Manager.
3. Expand the Multi-port serial adapters entry to view the list.
4. Right-click on the device you want to remove and select the Uninstall menu

item.
5. Select Ok at the Confirm Device Removal popup.
6. Close the Device Manager window and resume normal operations.

Installing the Driver

Use the following procedure to install the driver for the Windows 2000 operating
system.
Note: If you are updating the driver, first remove the existing version of the driver.

Do not use the Update option.
The following procedure assumes that you have already:
• Installed the hardware. See Locating Hardware Installation Documentation

on Page 5, if you need to locate the documentation.
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Installing the Driver
• Determined that the hardware is working properly using this table:

• If necessary, unzip the self-extracting files from the Comtrol media or ftp/web
site. See Locating NS-Link Software and Installation Documentation on Page
5, if you need to locate the device driver.

Use this procedure to install and configure the NS-Link device driver for your
device.
1. On the Windows desktop, right-click the My Computer icon. The shortcut

menu appears.
2. Select the Properties menu item. The System Properties window appears.
3. Select the Hardware tab.

Model Status

DeviceMaster
RTS

• The PWR LED on the front of the unit is lit,
indicating you have power and it has completed
the boot cycle.

• The red LNK/ACT LED is lit, indicating that you
have a working Ethernet connection.
Note: The red 100 LED may be lit, indicating a

working 100 MB Ethernet connection.

RocketPort
Serial Hub ia

• The yellow PWR LED is flashing, which means
that the device is waiting for the driver
installation.

• The green LNK LED is lit, indicating that you have
a working Ethernet connection.

• The yellow ACT LED flashes, indicating Ethernet
activity on the network.

RocketPort
Serial Hub Si

2-port

• Both 10/100BASE-T LEDs should be lit.
• The Power LED in the front of the unit is flashing,

which means that the device is waiting for the
driver installation.

RocketPort
Serial Hub Si

4/8-port

• The lower 10BASE-T LED should be lit (if using a
10Base-T Ethernet connection).

• The Port 1 LED is flashing, which means that the
device is waiting for the driver installation.
NS-Link Installation and Configuration 9



Installing the Driver
4. Select the Hardware Wizard button and then the Next button to start the
installation.

5. Select the Add/Troubleshoot a device option, and the Next button.

6. Choose Add a new device from the Devices list and the Next button.
NS-Link Installation and Configuration 10



Installing the Driver
7. Select the No, I want to select the hardware from a list option and the Next button.

8. Select Multi-port serial adapters from the Hardware types list and the Next
button.

Note: All Comtrol products are considered multi-port serial adapters.
9. Select the Have Disk button.
NS-Link Installation and Configuration 11



Installing the Driver
10. Enter the drive and directory path to the installation files and select the Ok
button. For example, if you extracted the driver to the default subdirectory,
enter: c:\comtrol

11. From the Models list, select the device you are installing and the Next button.

12. Select the Next button to start the driver installation.
NS-Link Installation and Configuration 12



Installing the Driver
13. If the Digital Signature Not Found dialog box appears, select Yes to proceed.

Note: It may take up to several minutes for Windows 2000 to load the driver.
14. Select the Finish button to complete the driver installation process.

Note: You may need to wait a few moments while Windows 2000 creates the
ports for the device in the operating system.
NS-Link Installation and Configuration 13



Installing the Driver
15. Select the Device Manager button.

16. Expand the Multi-port serial adapters entry, right-click on the device you are
installing, and select Properties menu item.
NS-Link Installation and Configuration 14



Installing the Driver
17. Highlight the device you want to configure and select the Properties button.

18. Optionally, rename the
NS-Link default name.

19. Verify the Number of
Ports on the device.

20. Optionally, set a
different KeepAlive
Timeout Period

You can set the amount
of time in seconds that
this device waits until it
closes this connection
and frees all the ports
associated with it. The
KeepAlive feature
works in the following
ways:
• During normal

operation the driver
periodically sends a
connection check to
the NS-Link device, and the device then returns a response. There are two
timers, one in the driver, and one in the device. These timers are reset
during the last synchronization signal and goes to the next signal. If a
connection is broken, the data is stored in the computer and the device.
Depending on the amount of time that has expired since the connection was
lost, the following happens:
- When the computer loses its connection to the device but re-establishes

it before the timeout period expires, any data transmitted during this
period is queued and sent when the connection resumes.

- When the computer loses its connection to the NS-Link device and does
not re-establish it before the timeout period expires; the driver then
purges any pending I/O data for ports on that connection and returns
all pending, and future I/O commands, with the exception of the Close
command, to the application with an error indicating the disconnected
status.

This is similar to the processing which occurs when the computer
NS-Link Installation and Configuration 15



Installing the Driver
receives a notification from the device that a port release request, from
FreePort, was processed on a port it owns with the exception that a
different status is returned. When the connection is re-established, the
computer will attempt to re-acquire the ports that were open when the
connection was lost. If the attempt is successful, normal operations
resume for the port. If any port has been acquired, then the computer
will continue to fail all further I/O operations, with the exception of a
Close request. When the Close request is received, the port can then be
re-opened.

- When the computer loses its connection to the NS-Link device, and the
time period expires, the device places the port into a state from which
another computer can establish a connection, locking out the original
driver when the connection is made. The driver will respond to all I/O
commands, with the exception of the Close command, with an error
indicating the disconnect status.

If you need the ability to reconnect with a port that another server is currently
using, Comtrol includes an utility called FreePort (Page 29) and its source code
which makes the API calls that would force a port closure. The included source
code for FreePort demonstrates the calls an application would make to perform
the same operation.
Note: If you want to use the device in an IP networking environment, you must

first install NS-Link with a MAC address and then configure the IP
address using the IP Programming tab in the NS-Link Device
Properties window.

21. If this is the initial NS-Link installation and you have not programmed an IP
address into the device, select MAC and enter the address on the MAC address
label (on the device). The MAC address format is: 00 C0 4E xx xx xx. A space
must separate each two digits. If your site has other Comtrol network devices
on the network, their MAC addresses will display in the droplist after initial
installation
If the device has been previously programmed with an IP address, you can
select IP and enter a unique reserved IP address or a qualified domain name
(DNS).
Note: If using DHCP or ARP, the administrator must reserve the MAC

address of the Comtrol device to the IP address assigned to the device. If
necessary, see your system administrator for a unique reserved IP
address or qualified domain name.

22. Select the Ok button to close the Device window.
23. Highlight the COM port that

you want to configure and select
the Properties button.
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Installing the Driver
24. Select the appropriate mode to
match the peripheral that you
are connecting to that
particular COM port.

25. Optionally, make any
necessary changes to fit your
environment:
a. Lock the baud rate to

access higher or lower
rates than are normally
permitted by your
Windows 2000
applications.

b. Set a time delay on the
transmit data before a
port closes.
Note: You can select the

length of time to
wait for data to
clear the transmit
buffer, before a close request from a host application is completed. If
data is still in the transmit buffer, you can set a delay time to allow
the buffer to empty. This is typically used with slower peripheral
devices such as printers, to give the data sufficient time to flush
through the system.

c. Map 2 stop bits to 1.
Note: You can use this option to map 2 stop bits to 1 bit. If the application

you are using is hard coded to use two stop bits and you are
receiving framing errors, you can implement this option. Leave this
box unchecked to enable stop bits to pass through unchanged.

d. Wait for physical transmission before completing write.
Note: Use this option to force all write packets to wait until the transmit

data has physically completed the transmission before returning
completion to the host application. The default mode (box not
checked) is to buffer the data in the transmit hardware buffer and
return completion as soon as the packet is in the buffer.

e. Emulate modem hardware ring signal.
Note: This emulates a hardware RI (ring indicator) signal.

f. Clone port settings.
Note: If this box is checked, the changes General category area are applied

to all NS-Link ports in the system. If this box is not checked, the
changes you make to the Port Setup options apply to the selected
port only.

g. Change the COM port name by selecting a new name in the COM name
drop list.
NS-Link Installation and Configuration 17



Installing the Driver
h. If you need to configure
RTS options, select the
RTS Toggle tab.

i. Configure the port and
select Ok after making the
appropriate selections.
The Override and lock to
RTS (Ready to Send) toggle
mode option allows you to
lock the port in RTS toggle
mode, then set the mode
(low or high) as desired.
The RTS Toggle RTS Low
option allows you to toggle
the RTS output signal low
during data transmission.
If the option box is not
checked, RTS is toggled
high (asserted) during
data transmission.

26. After configuring your port
(COM) properties, select the Ok
button. The Main Setup window
returns.

27. If you did not clone all the COM
ports, repeat Steps 23 through
26 until all of the COM ports
that you want to use are
configured.

28. Select the Ok button after you
have configured each port.

29. Select Yes to the Would you like
to add program manager menu
selections for the utilities.
Note: This adds a program

group under the Start
button to allow easy
access to the Test
Terminal and Portmon
applications. See Using
Test Terminal on Page 30
or Using Port Monitor on Page 32 for more information.
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Installing the Driver
30. Close the Device Manager.

31. Close the System Properties window.

32. Close the Comtrol NS-Link program group.
NS-Link Installation and Configuration 19



Installing the Driver
33. Select Shutdown from the
Start button and Restart your
system for the changes to take
affect.

34. After rebooting, verify that you
have a working installation.
DeviceMaster RTS: To verify
your installation, test a port
using Test Terminal (Page 30)
or check the Device Advisor
tab to see if the RTS is
functioning properly (Page 37).
RocketPort Serial Hub ia
• The yellow PWR LED is lit to indicate there is power and that NS-Link has

been downloaded to the device.
Note: If the PWR LED is still flashing, this means that the driver has not

downloaded to the device.
• The green LNK LED is lit to indicate that there is a working Ethernet

connection.
• The yellow ACT LED flashes to indicate Ethernet activity on the network.
RocketPort Serial Hub Si 2-port
• Both 10/100BASE-T LEDs should be lit.
• The Power LED in the front of the unit should lit.

Note: If the Power LED is still flashing, this means that the driver has not
downloaded to the device.

RocketPort Serial Hub Si 4/8-port
• The lower 10BASE-T LED should be lit (if using a 10Base-T Ethernet

connection).
• The Port LEDs on the front of the unit should be cycling their lights

approximately every 30 seconds.
Note: If the Port 1 LED is still flashing, this means that the driver has not

downloaded to the device.
35. Go to the appropriate subsection to configure NS-Link for your installation.

• To configure an IP address in the device, go to Programming the IP Address
on Page 22.

• To configure NS-Link in MAC mode to run efficiently, go to Disabling
DHCP Requests (MAC Mode) on Page 21.
NS-Link Installation and Configuration 20



Disabling DHCP Requests (MAC Mode)
Disabling DHCP Requests (MAC Mode)

After installing NS-Link and restarting the system, you may want to disable the
DHCP requests that are periodically sent from the device. Use the following
procedure to disable DHCP requests sent from the Comtrol device.
Note: MAC must be checked in the Device window as discussed in Step 21 on Page

16.
1. On the Windows desktop, right-click the My Computer icon and select the

Manage menu item.
2. Expand the Multi-port serial adapters entry and

highlight the device you are configuring.
3. Highlight the device name for which you want

to disable DHCP requests and select
Properties.

4. Select the IP
Programming tab.

5. Select the Disable
button.

6. Select the Reset
button and wait
until the device
reloads.
Note: The Comtrol

device cycles
its LEDs.

7. Select Ok to close
the Device window.

8. Select Ok to close
the Properties
window.
NS-Link Installation and Configuration 21



Programming the IP Address
Programming the IP Address

After installing NS-Link and restarting the system, use the following procedure to
program the IP address in the Comtrol device.
Note: To perform the following procedure, you must have previously entered the

MAC address in the Device Setup tab and rebooted your system.
See your System Administrator to acquire a unique reserved IP address if you are
using DHCP. They will need the MAC address of the unit to provide you with an
IP address.
1. On the Windows desktop, right-click the My Computer icon and select the

Manage menu item.
2. Expand the Multi-port serial adapters entry

and highlight the device you are installing.
3. Highlight the device name of the unit you

want to program and select Properties.
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Programming the IP Address
4. Select the IP
Programming tab.

5. Select the Retrieve
button to check to
see if the Comtrol
device has been
programmed with
an IP address,
gateway, and subnet
mask.

6. Select the Ok button
to retrieve the
values.

7. If NS-Link
retrieves the
values assigned by
the System
Administrator, this
means that the
hardware has been
previously
configured and go to
Step 21.

Note: The default address for the DeviceMaster RTS is 192.168.250.250.
If NS-Link returns all zeros, go directly to Step 8.
If NS-Link did not retrieve the correct values (not zeros), select the Clear
button.
a. Select the Clear button.
b. Select the Ok button to clear the IP programming in the device.
c. Select the Ok button to the IP programming not complete until the device

is reset popup.
d. Select the Reset button and wait until the device reloads.

Note: The Comtrol device cycles its LEDs.
NS-Link Installation and Configuration 23



Programming the IP Address
8. Enter the IP address, subnet mask, and gateway values in the IP Settings area.

9. Select the Program button.
10. Select the Ok button to begin programming the device.
11. Select the Ok button to the IP programming not complete until the device is

reset popup.
12. Delete the contents of the IP Address, Gateway, and Subnet Mask fields.

13. Select the Retrieve button.
14. Select the Ok button to retrieve IP programming from the device.
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Programming the IP Address
15. Verify that the
information that
loads into the IP
Address, Gateway,
and Subnet Mask
fields matches the
information that you
previously entered.
If not, re-enter the
IP Address,
Gateway, and
Subnet mask
information and
repeat Steps 9
through 13.

16. If you are not using
DHCP or ARP, then
select the Disable
button.

17. Select the Reset
button to soft boot
the device.
Note: The Comtrol device cycles its LEDs.

18. Select the Ok button to reset the entire device.
19. Select the Device tab.
20. Uncheck the MAC box and then check the IP checkbox.
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Programming the IP Address
21. Select the Ok button to close the Device window.

22. Select the Ok button to close
the Setup window:

23. Save the configuration
changes and exit.

24. Reboot the server and verify
that the device is running
properly using Step 34 on
Page 20.

25. Connect your serial devices to
the Comtrol device. If you
need information about
connecting your serial devices,
see Locating Hardware
Installation Documentation on
Page 5 for your product.

26. Set up modems or printers
using your Windows 2000
documentation.

27. DeviceMaster RTS: If you
want to configure any of the
ports as sockets:
a. Enter the IP address of the device in your web browser URL field.
b. Select the port number that you want to configure as a socket.
Note: See the DeviceMaster RTS Installation and Configuration Guide if you

need help configuring sockets. You can download the latest version at:
ftp://ftp.comtrol.com/Dev_Mstr/RTS/RTS_Library.pdf.
NS-Link Installation and Configuration 26
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Changing Device Properties
Changing Device Properties

You can change the device name and number of configured ports after initial
configuration. In addition, you can establish a KeepAlive timeout period. See Page
15, Step 20 for a description of the KeepAlive timeout period.
Use Programming the IP Address on Page 22 to change the IP address.
Use the following procedure to change device properties.
1. Use the Device

Manager to access the
Main Setup window
(see Steps 1 through 3
on Page 22.

2. After making your
changes, click Ok and
follow any other driver
prompts.
Note: Use the Help

button if you
need detailed
information
about procedures
or use context-
sensitive help for
any field.

Changing COM Port Properties

You can optionally configure the following COM port properties:
• Change device mode (RS-232/422/485).
• Lock baud rate.
• Set timeout on transmit data.
• Map stop bits.
• Set the port to wait on physical transmission before completing the write.
• Emulate modem hardware ring signal.
• Clone all ports.
• Reset to default values.
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Adding Additional Devices
Use the following procedure to change COM port properties:
1. Use the Device Manager to access the Main Setup window (see Steps 1

through 2 on Page 22).
2. Highlight the port that you want to configure and select the Properties button.

3. Use Steps 24 through 26 (Page
17 through Page 18) if you
need information about
configuring port
characteristics.
Note: Use the Help button if

you need detailed
information about
procedures or use
context-sensitive help
for any field.

Adding Additional Devices

Install the device and configure the ports using the same procedures in the
Installing the Driver section on Page 8.
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Using Freeport

FreePort is an application utility that provides a simple mechanism to
communicate to the NS-Link device driver that it should request the physical
device to close the physical ports which are associated with the specified logical
ports.
See the Freeport.cpp file (bundled with the driver) for a simple example on how
other applications could implement this capability themselves. The Freeport.cpp
file can be found in the C:\WINNT\System32\RpshSi subdirectory after driver
installation.



Comtrol Tools

The following subsections discuss the following utilities that are shipped with
most Comtrol drivers for Microsoft operating systems:
• Test Terminal program (wcom32.exe), which can be used to troubleshoot

communications on a port-by-port basis.
• Port Monitor program (portmon.exe), which checks for errors, modem control,

and status signals (Using Port Monitor on Page 32). In addition, it provides
you with raw byte input and output counts.

• Device Advisor, which helps identify problems is a tab in the Device window of
the NS-Link driver (Using the Device Advisor on Page 37).

• If Windows NT, Peer Tracer program (peer.exe), which traces driver events.

Using Test Terminal

WCOM32 is a terminal program that enables you to open a port, send characters
and commands to the port, and toggle the control signals.
Note: WCOM32 will not work on ports used by RAS if Remote Access Service is

running or any other application is using the port. If you are using RAS,
you must stop the service before starting WCOM32 to test RAS COM ports.
To test ports that are not used by RAS, you do not need to stop RAS.

Follow these steps:
1. To start

WCOM32, select
Test Terminal
from the Comtrol
program group.
The program
window displays:

2. Select Open Port
from the Port
menu. A list of
possible COM
port numbers displays.

3. Select the COM port you want to test.
If the COM port does not exist or if it is currently being used by another
program, a Create File Error message displays.
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Testing a Comtrol Device
If the COM port is
available, a terminal
window pops up:
Note: Notice the

<loop> button in
the terminal
window. If this
option is
activated, it is
green and
uppercase
( ), the
COM port
internal
loopback feature
is activated, and
the data is returned by the COM port hardware. If this option is
deactivated, it is gray and lowercase ( ), the internal loopback is
deactivated, and the data is sent out the COM port.

Testing a Comtrol
Device

Use the following procedure to test the Comtrol device.
1. Place a loopback plug on the COM port you are testing. Make sure all

connectors are seated firmly and that the loop button is off.
Note: Test terminal works for RS-232 and RS-422 mode.
To build loopback plugs, see the hardware installation document for the
Comtrol device.

2. From the Port menu, select Send Test Data. The program sends out a repeating
data stream.
Note: To stop the data stream, select Send Test Data again.
• If the loopback plug is in place and the port is working correctly, the test

data should be echoed back to the screen.
• If the loopback plug is not in place or the port is not working correctly, no

data or garbled data is echoed back to the screen.
Note: If no characters appear, try putting the loopback plug on an adjacent

port. It may be that you have the ports mixed up.
3. If further testing is required, select Loopback Test from the Port menu.

If the loopback plug is in place and
the port is working correctly, the
system should return the message
Passed.
If the loopback plug is not in place
or the port is not working correctly,
the system will return the message
Failed.

Testing a Comtrol
Device (RS-485)

Perform the following procedure to determine if a port or ports are functioning
properly.
1. Connect a straight-through cable from Port 1 to Port 2.

Note: See the hardware installation document for the Comtrol device if you
need to build a cable.

If testing ports other than Ports 1 and 2, simply connect the cable
between any two ports.

2. Open a session for each port.
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Test Terminal Modem Control Signals
3. Enter data into the Port 1 session, the data should appear in the Port 2
window.

4. Enter data into the Port 2 session, the data should appear in the Port 1
window.
Note: If the data appears as described in Steps 3 and 4, the hardware is

functioning properly.

Test Terminal
Modem Control
Signals

The terminal window displays the modem control signals as gray
or green lights at the top of the window. The first four are inputs:
The lights are green if they are turned on, or gray if off. The text
on the light also changes from uppercase (CTS), which is on, to lowercase (cts),
which is off.
The next two lights are outputs:
Note: If you have a loopback plug connected and you click on one of the outputs,

the corresponding signal is sent to the input and the input lights should
toggle accordingly.

The rightmost light is the loop indicator:
If this is on, the COM port internal loopback feature is activated and any
information or code entered in the terminal window loops back through the COM
port circuitry. If this is off, the COM port internal loopback is deactivated, and any
information or code entered in the terminal window is sent out of the port.

Using Port Monitor

The Port Monitor program (portmon.exe) offers a summary of all Comtrol device
statistics in one spreadsheet view. It also enables you to verify operation of all
Comtrol device ports from a single window.
The Port Monitor display follows the familiar spreadsheet model: each COM port
is a horizontal row, and each vertical column displays a variable or value for the
respective COM port. For definitions of the abbreviations used, see Port Monitor
Variables on Page 35.
Port Monitor can also produce statistics and reports that can help you verify the
operation of the COM ports and connected peripherals. Some immediate feedback
includes:
• The state of the modem control and status signals
• Open ports
• Raw byte input and output counts obtained from NS-Link
• Port errors
The available statistics include:
• Instantaneous characters per second (CPS) calculations
• Minute, hour, and day CPS averages and peaks
• Carrier detect (CD) signal runtime and transition count
Reports can be automatically generated on an hourly and/or daily basis, and can
cover all ports collectively or a separate report for each port. You can also set how
often the values are recalculated, fine-tuning thoroughness against system
efficiency, and automatically run external batch files to perform additional
processing and analysis.
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Starting Port Monitor
Starting Port
Monitor

To run Port Monitor, select Port Monitor from the Comtrol program group. The
monitor window displays:

Note: To change the appearance of the screen, see the following discussion.
Once the monitor window displays, Port Monitor is active and collecting data. If
any cumulative data has been saved from previous sessions, it is automatically
brought in and used.
Port Monitor continues to run and collect data until you terminate it, at which
point all accumulated data is automatically saved for use in the next session.

Changing Screen
Appearance

While Port Monitor is running, there are a number of commands and controls that
change the appearance of the screen.

* The Reset command does not clear raw data from the calcs.dat file. It simply
resets the selected display fields to their null values. For more information
regarding calcs.dat see page 90.

Desired Change Procedure

Change the monitor
window font. Select Font from the Edit menu.

Change width of a
single column.

Left-click on the column separator (vertical) line and
drag it to the desired width.

Change column
placement.

Left-click in the middle of the column you want to
move and drag it to the desired location.

Remove a column. Right-click on the column you want to remove and
select Remove from the pop-up menu.

Clear all fields and
reset them to null
values.

Right-click on the upper left cell in the table and select
Reset from the pop-up menu.*

Clear any single field
except the upper left
cell.

Right-click on the field to be cleared and select Reset
from the pop-up menu.*

Add a column.

Right-click on the column now occupying the desired
location and select Add from the pop-up menu.
You are prompted to name the variable you want to
display, as well as other information. (See Column
Setup, below.)
After you click OK, the column is inserted in the
selected location and the existing column is moved to
the right.

Change other properties
of a column.

Right-click on the column and select Properties from
the pop-up menu. (See Column Setup, below.)
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Column Setup
Column Setup When you select Add or Properties from
the column pop-up menu, the Column
Setup window displays:
• Use the Input droplist to select the

variable displayed in the column.
• Use the Type droplist to select the

way in which the value displays:
either as an integer, as an on/off
state, as an integer with a kilo,
mega, or giga suffix, or as an
hh:mm:ss time stamp. This defaults
to the appropriate type for the
selected Input variable.

• Use the Name variable to change
the column heading name.

• Use the Width variable to specify
the column width in characters.

• Use Color0 to set the column character color when the value is zero.
• Use Color1 to set the column character color when the value is not zero.
• When done, click OK to save your changes and return to Port Monitor.

Report
Configuration

To configure reports, select
Config from the Edit menu.
The Single report options
cover all ports and are
overwritten each time the
reports are generated. The
Multiple report options
generate a separate report
for each port, and each
report file is appended each
time the report is generated.
For Hour reports, use the
Single and Multiple
droplists to select whether
you are generating single or
multiple reports, or both.
For each report type, select
from the following types of
data to include:
• None: no report is generated.
• Hour Data: only variables with “Hour” in the name are included.
• All Data: all variables are included.
• View Data: only variables that appear on-screen are included.
The External Program field is used to enter a command line to run another
program after the hourly reports have been generated. For example, you can use
this to run a batch file that performs custom report processing. The Test button
causes the command line to be executed immediately.
For Day reports, the single and multiple droplists behave the same, but your
choices are:
• None: no report is generated.
• Day Data: only variables with the words “Day” or “Raw” in the names are

included.
• All Data: all variables are included.
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Port Monitor Files
• View Data: only the variables that appear in the Port Monitor window are
included.

Likewise, the External Program field is used to enter a command line to be
executed after the daily reports have been generated.
The Update Time option allows you to set the rate at which the port information is
obtained and the calculations performed. There is a trade-off between Port
Monitor efficiency and response time. If you are using Port Monitor to view the
port activity on the screen, you may want to set the update time to 1 or 2 seconds,
so that the screen is updated frequently. If you are concerned about the monitor
program using CPU resources, set this to a higher value, (6 to 20 seconds) in order
to decrease the time required by the program to perform the calculations and
update the screen.
If Port Monitor is left active to generate reports, minimizing or reducing the
display area of the program will help reduce the CPU overhead of updating the
screen.

Port Monitor Files Port Monitor creates and uses the following files:
• portmon.vew

• calcs.dat

The default column layout is saved in portmon.vew. If you have been experimenting
with the appearance of the monitor screen, you can use the File menu Save option
to save your customized layout in another.vew file. You can retrieve this file later
by using the File menu Open option, or you can use the Edit menu View Default
option to retrieve portmon.vew and restore the default view.
All Port Monitor calculations are saved at program exit and on the hour in a
binary file named calcs.dat. This enables you to halt Port Monitor execution
without losing accumulated data.
Port Monitor also creates a \REPORTS directory. All hourly and daily reports are
saved in this directory, under the following names:
• hall.txt — hourly single report
• dall.txt — daily single report
• hcomx.txt — hourly multiple reports, where x is the port number
• dcomx.txt — daily multiple reports, where x is the port number
Caution: Since multiple reports append new data each time they are written, the

multiple report files grow in size. It is up to you to delete them
periodically.

Some safeguards are built into the program to avoid filling up a hard disk drive
due to growing report files. The monitoring program stops writing additional data
to the multiple reports if they reach a size of 2 MB. Also, the program will not
write out data files to the disk drive if the spare room on the drive is less than 2
MB in size.
To view or edit an hourly or daily report, use the Edit Report option on the File
menu, or use a system tool such as NOTEPAD.
For more information, see the Port Monitor Help file.

Port Monitor
Variables

The following table lists Port Monitor variables.

Variable Description

Open Open status, on if open, off if closed.

Cts Input CTS pin status.

Dsr Input DSR pin status.
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Port Monitor Variables
Cd Input CD (carrier detect) pin status.

Rts Output RTS pin status.

Dtr Output DTR pin status.

TxTotal Total bytes transmitted.

RxTotal Total bytes received.

TxCPSInst Instantaneous average of transmit characters per
second.

RxCPSInst Instantaneous average of receive characters per
second.

Errors Total hardware receive errors (parity, framing, and
overruns.)

TxMinCPS Last minute average of transmit characters per
second.

RxMinCPS Last minute average of receive characters per
second.

TxCPSMinAvMax Peak TxCPSInst for the last minute.

RxCPSMinAvMax Peak RxCPSInst for the last minute.

TxCPSHourAvMax Peak TxMinCPS for the last hour.

RxCPSHourAvMax Peak RxMinCPS for the last hour.

TxCPSDayAvMax Peak TxMinCPS for the last day.

RxCPSDayAvMax Peak RxMinCPS for the last day.

TxTotalRaw Total number of transmit bytes raw data from NS-
Link.

RxTotalRaw Total number of receive bytes raw data from NS-
Link.

TxMinCnt Count of transmit bytes sent in last minute.

TxHourCnt Transmit bytes count sent in the last hour.

TxDayCnt Transmit bytes count sent in the last day.

RxMinCnt Receive bytes count sent in the last minute.

RxHourCnt Receive bytes count sent in the last hour.

RxDayCnt Receive bytes count sent in the last day.

TxMinCntWrk Transmit bytes count sent in this minute.

TxHourCntWrk Transmit bytes count sent in this hour.

TxDayCntWrk Transmit bytes count sent in this day.

RxMinCntWrk Receive bytes count sent in this minute.

RxHourCntWrk Receive bytes count sent in this hour.

RxDayCntWrk Receive bytes count sent in this day.

TxCPSMinAvMaxWrk Peak TxCPSInst for the current minute.

TxCPSHourAvMaxWrk Peak TxMinCPS for the current hour.

TxCPSDayAvMaxWrk Peak TxHourCPS for the current day.

RxCPSMinAvMaxWrk Peak RxCPSInst for the current minute.

Variable Description
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Using the Device Advisor

You can use the Device Advisor to determine the following information:
• Summary of the device status
• The MAC address of the network interface card (NIC)
• The Adapter ID string
• The Comtrol device’s MAC address
• Detailed state of the Comtrol device
• Total number of successful load attempts
• Total number of devices on the network
• Transmit statistics, such as the number of:

- Frames out
- Packets to device
- Retransmitted frames

• Receive statistics, such as the number of:
- Frames accepted
- Frames passed on
- Packets from device

RxCPSHourAvMaxWrk Peak RxMinCPS for the current hour.

RxCPSDayAvMaxWrk Peak RxHourCPS for the current day.

CDRuns Carrier detect turn-on count.

CDDayRuns Carrier detect turn-on count in the last day.

CDDayRunsWrk Carrier detect turn-on count in the current day.

CDRunTime Time in seconds carrier detect has been on.

CDHourRunTime Time in seconds carrier detect has been on in the
last hour.

CDDayRunTime Time in seconds carrier detect has been on in the
last day.

CDHourRunTimeWrk Time in seconds carrier detect has been on this hour.

CDDayRunTimeWrk Time in seconds carrier detect has been on this day.

StatusFlags Bit flags, Open, CTS, DSR, CD, RTS, DTR

TxPkts Raw count of total transmit packets sent.

RxPkts Raw count of total receive packets sent.

OverrunErrors Total count of receive overrun errors.

FramingErrors Total count of receive framing errors.

ParityErrors Total count of receive parity errors.

OverrunErrorsRaw Total count of receive overrun errors, from NS-Link.

FramingErrorsRaw Total count of receive framing errors, from NS-Link.

ParityErrorsRaw Total count of receive parity errors, from NS-Link.

Variable Description
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Starting the Device Advisor
- Out of sequence frames
Note: For detailed information about the fields in the Device Advisor, use the on-

line help available in the application.

Starting the Device
Advisor

Use the following procedure to access the Device Advisor:
1. Start the NS-Link menus using the Start button.
2. Highlight the device that you want to review and select the Properties button.

3. Click on the Device Advisor tab.

The Device Advisor screen appears providing you with information that you
may find useful.
Note: For information about the fields in the Device Advisor, use the on-line

help available in the application.
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Device Advisor Driver Messages
Device Advisor
Driver Messages

The following tables provide information about device driver summary messages
and reported state messages.

Message Description

Unintialized Comtrol device has not been installed correctly.

Unable to contact the NS-
Link driver

The Comtrol device NS-Link is not installed or is
not responding to Device Advisor requests.

Unable to contact a Network
Interface Controller (NIC)

The server NIC card may not be installed, may be
malfunctioning, or may not be bound to the
Comtrol device.

Cannot detect network
No inbound traffic of any sort Comtrol device may
be inoperative or you may have a network cabling
problem.

Cannot detect any NS-Link.
Network traffic is being received, but not from a
Comtrol device. Check the network connections
and verify that the Comtrol device is powered up.

Cannot detect NS-Link with
specified MAC address.

Network traffic is being received from a Comtrol
device, but not the one specified in Device Setup.
Check the device to make sure that you are using
the correct MAC address in Device Setup, and
check the Main Setup window to verify that you
are working with the correct device.

NS-Link device with specified
MAC address was detected,
but is not configured for this
server.

Either the Comtrol device in question is not
assigned to this server, or it is not assigned to any
server, or it has been configured for this server but
the configuration has not been saved. If the latter,
return to the Setup window, save and exit, and
restart the server

NS-Link device detected and
configured for this server, but
is not yet assigned to this
server.

Either the Comtrol device is currently being
controlled by another server or the device power
has been cycled and the device is waiting for a
server to acquire it.

NS-Link detected,
initializing.

The server has acquired the Comtrol device and is
downloading the control program. The device will
be available shortly.

NS-Link responsive, but no
data traffic exchange since
last inquiry.

The Comtrol device appears to be installed
correctly and active, but no data traffic has been
sent or received since the last time you clicked the
Refresh button. If there should have been traffic,
check the Comtrol device port configuration and
external cabling.

NS-Link responsive; data
traffic received, but nothing
sent since last inquiry.

Similar to above, except the Comtrol device has
received data successfully.

NS-Link responsive; data
traffic sent, but nothing
received since last inquiry.

Similar to above, except the Comtrol device has
sent data successfully.

NS-Link active. Normal state: the Comtrol device is installed
correctly and active with data traffic.

Poor connection to NS-Link.

This message displays if retransmissions occur,
frames arrive out of sequence, or more than 2% of
the total packets arrive out of sequence. This
generally indicates a cable, connector, or LAN
termination problem.
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Using Peer Tracer

The Peer Tracer program (peer.exe) is specifically designed to view the internal
operations of NS-Link for the purpose of troubleshooting communications on
Windows NT systems. Peer enables you to see:
• Receive and transmit data
• Internal driver event traces
• Advanced configuration and status information
Like Test Terminal, Peer acts as a simple terminal session, and is used to send and
receive text information to and from NS-Link. To use Peer, you type in commands,
and status and information are sent back.
Unlike Test Terminal, Peer enables you to keep a continuous log of the commands
sent and the results received in a file named peer.log.
Comtrol Technical Support may ask you to run Peer in order to help diagnose
reported problems.

Starting Peer Peer Tracer does not
appear in the Comtrol
program group. To use
it, you must open
Windows Explorer, access
the
C:\WINNT\system32\rpsh
Si directory, and double-
click on peer.exe. The
Peer Tracer window
displays (at right).

Counts reset. This message displays immediately after you click
the Reset button.

Message Description

Invalid An illegal Comtrol device state has been detected. Reset the
Comtrol device.

Init This is the normal state for undetected and inactive Comtrol
device.

InitOwn The server has acquired the Comtrol device but has not
downloaded the control software.

SendCode The server has acquired the Comtrol device and is in the process of
downloading the control software.

Connect The server has completed the download and is completing
initialization.

Active The normal state for a Comtrol device that is attached to a server
and is ready for data traffic.

Not found The specified MAC address is not configured on this server.

Undefined No Comtrol devices are configured on this server.

Message Description
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Log Functions
Log Functions All logging functions are found under the File menu. To start keeping a log, select
Log to Disk from the File menu. The other options on this menu are View Disk Log,
Clear Disk Log, Clear Screen, and Exit.

Using Peer To use peer, simply type in commands at the : prompt. (It may be necessary to
press Enter to make the : prompt appear.) For example, to examine COM5, type:
PORT COM5 <Enter>

To gather some information about the port, type: STAT <Enter>. This should
return details about the port.
To turn on monitoring of any calls into driver (events), type: MON EV <Enter>

To send strings and commands to attached peripherals—for example, to send
“ATH0” to a modem—type: SEND ATH0 <Enter>. A return and linefeed are always
appended to each string sent.

Other Peer
Commands

Enter commands at the : prompt and follow each command with Enter.

Keep in mind that all commands are processed in NS-Link, and that Peer simply
acts as a conduit for this information.
For more information, see the Peer.hlp help file.

Command Effect

MON TX Monitor data being transmitted through the selected port.

MON RX Monitor data being received through the selected port.

M Turn off all monitoring.

? Display Peer Tracer command summary.

PORT COMxx Change port being examined to COMxx.
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Troubleshooting and Technical Support

This section contains troubleshooting information for your Comtrol device. You
should review the following subsections before calling Technical Support because
they will request that you perform many of the procedures or verifications before
they will be able to help you diagnose the problem.
• Troubleshooting checklist
• General Troubleshooting on Page 43
• NS-Link Driver Troubleshooting on Page 45
• Daisy-Chaining DeviceMaster RTS Units on Page 47
If you cannot diagnose the problem, you can contact Technical Support using
Technical Support on Page 48.

Troubleshooting Checklist

The following checklist may help you diagnose your problem:
• Verify that you are using the correct types of cables on the correct connectors

and that all cables are connected securely using the hardware documentation.
Note: Most customer problems reported to Comtrol Technical Support are

eventually traced to cabling or network problems.

If DeviceMaster RTS: Use a standard Ethernet cable to connect from
the UP port to an Ethernet hub or from the DOWN port to a NIC in a
server.

If RPSH-ia or RPSH-Si: Use a standard Ethernet cable to connect
from the device to an Ethernet hub or a cross-over Ethernet cable to
connect from the device to a NIC in a server.

• Verify that the ethernet hub and any other network devices between the
server and the Comtrol device are powered up and operating.

• If you are using a 10/100mb NIC card with a RocketPort Serial Hub Si (4/8-
port), try locking the card to 10mb/s.

• Reset the power on the Comtrol device.
- If the device has a power switch, turn the device’s power switch off and on,

while watching the LED diagnostics.
Note: If it is a RocketPort Serial Hub Si 4/8-port unit, run the diagnostics

program.
- If the unit does not have a power switch, disconnect and reconnect the

power cord.
• Verify that the port polarity is correct, especially if using RS-422 or RS-485

mode.
• Verify that the network (MAC) address in NS-Link matches the address on the

Comtrol device.
• Verify that the network IP address is correct. If IP addressing is being used,

the server should be able to ping the Comtrol device.
• Verify that the IP address programmed into the Comtrol device matches the

unique reserved IP configured address assigned by the system administrator.
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General Troubleshooting
• If using a driver for Microsoft systems, verify that you are addressing the port
correctly. In many applications, device names above COM9 require the prefix
\\.\ in order to be recognized. For example, to reference COM20, use
\\.\COM20 as the file or port name.

• If using NS-Link for a Microsoft system, you can use one of the tools bundled
with the drivers:
- Test Terminal program (wcom32.exe), which can be used to troubleshoot

communications on a port-by-port basis.
- Port Monitor program (portmon.exe), which checks for errors, modem

control, and status signals. In addition, it provides you with raw byte
input and output counts.

- Device Advisor, which helps identify problems is a tab in the Device
window of the driver.

- If Windows NT, Peer Tracer program (peer.exe), which traces driver events.
• If using Windows NT, enable the Verbose Event Log feature under the Setup

Options tab and then reboot the server.
• Reboot the server and the Comtrol device.
• Isolate the unit from the network. Connect the device directly to the NIC in

the server.
- DeviceMaster RTS: Use a standard Ethernet cable and connect to the port

labeled: DOWN.
- RocketPort Serial Hub Si or ia: Use an Ethernet cross-over cable.

• Remove and reinstall NS-Link.
• If you have a spare Comtrol device, try replacing the device.

General Troubleshooting

This table illustrates some general troubleshooting tips.
Note: Make sure that you have reviewed the Troubleshooting Checklist on Page 42.

General Condition Explanation/Action

PWR LED flashing
(RocketPort Serial Hub
Si and RocketPort Serial
Hub ia, only)

Indicates that boot program has not
downloaded to the unit.
1. Make sure that you have downloaded the

most current driver from http://
support.comtrol.com/download.asp.

2. Install the driver and configure the device
using the MAC address. Make sure that you
reboot the server.
Note: If the PWR LED is still flashing,

contact Technical Support.
3. If you want to program an IP address into

the Comtrol device, you can use the
procedure outlined in NS-Link Driver
Troubleshooting on Page 45.

4. Remove the NS-Link driver.

PWR LED not lit
Indicates that power has not been applied or
there is a hardware failure. Contact Technical
Support.
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General Troubleshooting
Can ping the Comtrol
device, but cannot open
the ports from a remote
location.
(You must have
previously programmed
the IP address, subnet
mask, and IP gateway.)

The NS-Link driver uses Port 4606 (11FE h) to
communicate with the Comtrol device.
When using a “sniffer” to track NS-Link
packets, filtering for Port 4606 will easily track
the packet. The packet should also contain the
MAC address of the device and the originating
PC so that it can be determined if the packet is
able to travel the full distance one way or not.
If the 4606 packet is found on one side of a
firewall or router, using sniffer, and not on the
other side, then that port needs to be opened up
to allow the 4606 to pass.
This will most often be seen with firewalls, but
is not uncommon in some routers.

Cannot ping the device
through Ethernet hub

Isolate the unit from the network. Connect the
device directly to the NIC in the server.
• DeviceMaster RTS: Use a standard

Ethernet cable and connect to the port
labeled: DOWN.

• RocketPort Serial Hub Si or ia: Use an
Ethernet cross-over cable.

Cannot ping or connect
to the DeviceMaster
RTS.

The default IP address is often not accessible
due to the subnet masking from another
network unless 192.168 is used in the network.
In most cases, it will be necessary to program in
an address that conforms to your network.
If you do not use the NS-Link driver to program
the IP address, you only have 10 seconds to
disable the bootloader with Redboot to get into
the setup utility.
See ftp://ftp.comtrol.com/Dev_Mstr/RTS/
RTS_Library.pdf for the Redboot method of
programming an IP address.

General Condition Explanation/Action
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NS-Link Driver Troubleshooting
NS-Link Driver Troubleshooting

This table includes some tips related to NS-Link drivers.

NS-Link Condition Explanation/Action

Need to program IP
address into the
device.

Before programming an IP address it is critical that the
unit be operational and passes the power on tests when
configured for the MAC address.
Note: If the unit is NOT operational, do NOT attempt to

program or use an IP address with the unit.
This is a general procedure for drivers for Microsoft
operating systems.
1. In the Comtrol Setup, highlight the Comtrol device.
2. Select Properties.
3. Select IP Programming.
4. Select Retrieve and confirm or modify addresses as

necessary.
Note: Enter in all 3 categories. The unit must have

Address, Mask and Gateway IP values entered.
5. Select Program.
6. Select Reset - power LED should begin blinking.
7. Select Device Setup.
8. Uncheck MAC.
9. Check IP and enter IP number that you configured

earlier.
10. Select Ok (several times) and reboot the system.
IP addressing will now be in effect.

Cannot open port

1. Verify that MAC address in the NS-Link driver
matches the address on the Comtrol device.

2. Verify that you are using the correct NS-Link driver. If
necessary, remove and reinstall a new driver.

3. Isolate the unit from the network. Connect the device
directly to the NIC in the server.
• DeviceMaster RTS: Use a standard Ethernet cable

and connect to the port labeled: DOWN.

• RocketPort Serial Hub Si or ia: Use an Ethernet
cross-over cable.

4. Check to see if another program or computer is active
on this port.
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NS-Link Driver Troubleshooting
The Comtrol device
has a lower
limitation of network
bandwidth
requirement of 64
Kbps.

At this speed the entire available bandwidth is required for
the purpose of uploading the firmware from the driver to
the Comtrol device. At lower speeds, timing issues will
prevent the firmware from being successfully installed to
the Comtrol device, thus preventing the device from
normal operation.
When using the Comtrol device over a WAN link that is
less than the recommended 64Kbs, a timing modification
may be made that will allow uploading of the firmware.
There are two possible solutions.
1. Load the driver locally to the device for the purpose of

getting the firmware installed. The PC on the other
side of the slow link can then “share” the port. The
sharing may be exclusive as the firmware loader PC
may not need to access the ports.

2. Modify the Scan Rate setting to an unusually high
value. The default value for the Scan Rate is 10 ms.
Changing this rate may cause decreased performance
as it may be necessary to increase this value to several
seconds as opposed to milliseconds. This may also
require some experimentation to determine the lowest
value that will provide successful uploading of the
firmware. With experimentation, Scan Rate values of
less that 5000 ms may be attempted.
A value of 5000 ms has been successfully used to
upload the firmware across connection lines as slow at
14.4 Kbps. This is the only value that the following
Kbps/duration values will be demonstrated.
Bandwidth of less than 14.4K has not been tested and
is not recommended under any circumstance but is a
decision to be made by the end user with
considerations of device port speed requirements,
duration of transmissions, frequency of transmissions,
etc.
With the Scan Rate set to 5000ms.

Connection speed Time required
(bandwidth): to upload firmware:

32K 3 minutes
28.8K 3.5 minutes
19.2K 4 minutes
14.4K 4.5 minutes

If you need help changing the Scan Rate value in the
Options field. See the NS-Link installation document for
your operating system or use the help system in the driver.

NS-Link Condition Explanation/Action
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Daisy-Chaining DeviceMaster RTS Units
Daisy-Chaining DeviceMaster RTS Units

DeviceMaster RTS products follows the IEEE specifications for standard Ethernet
topologies.
When using the UP and DOWN ports, the DeviceMaster RTS is classified as a
switch. When using the UP port only, it is a simple end node device.
The maximum number of DeviceMaster RTS units, and the maximum distance
between units is based on the Ethernet standards and will be determined by your
own environment and the conformity of your network to these standards.
Comtrol has tested with seven DeviceMaster RTS units daisy-chained together
using 10 foot CAT5 cables, but this is not the theoretical limit. You may experience
a performance hit on the devices at the end of the chain, so it is recommended that
you overload and test for performance in your environment. The OS and the
application may also limit the total number of ports that may be installed.
Following are some quick guidelines and URLs of additional information. Please
note that standards and URLs do change.
• Ethernet 10BASE-T Rules

- The maximum number of repeater hops is four.
- You can use Category 3 or 5 twisted-pair 10BASE-T cables.
- The maximum length of each cable is 100m (328ft).

Note: Category 3 or 5 twisted pair cables look the same as telephone cables
but they are not the same. The network will not work if telephone
cables are used to connect the equipment.

• Fast Ethernet 100BASE-TX rules
- The maximum number of repeater hops is two (for a Class II hub). A Class

II hub can be connected directly to one other Class II Fast Ethernet hub. A
Class I hub cannot be connected directly to another Fast Ethernet hub.

- You must use Category 5 twisted-pair 100BASE-TX cables.
- The maximum length of each twisted-pair cable is 100m (328ft).
- The total length of twisted-pair cabling (across directly connected hubs)

must not exceed 205m (672ft).
Note: Category 5 twisted pair cables look the same as telephone cables but

they are not the same. The network will not work if telephone cables
are used to connect the equipment.

• IEEE 802.3 specification: A network using repeaters between communicating
stations (PCs) is subject to the "5-4-3" rule of repeater placement on the
network:
- Five segments connected on the network.
- Four repeaters.
- Three segments of the 5 segments can have stations connected. The other

two segments must be inter-repeater link segments with no stations
connected.
See http://www.optronics.gr/Tutorials/ethernet.htm for more specific
information.
Additional information may be found at http://compnetworking.about.com/
cs/ethernet1/ or by searching the web.
Troubleshooting and Technical Support 47

http://www.optronics.gr/Tutorials/ethernet.htm
http://compnetworking.about.com/cs/ethernet1/
http://compnetworking.about.com/cs/ethernet1/


Technical Support
Technical Support

If you need technical support, contact Comtrol using one of the following methods.

Contact
Method

Corporate
Headquarters Comtrol Europe

FAQ/Online http://support.comtrol.com/support.asp

Downloads http://support.comtrol.com/download.asp

Email support@comtrol.com support@comtrol.co.uk

Web site http://www.comtrol.com http://www.comtrol.co.uk

Fax (763) 494-4199 +44 (0) 1 869-323-211

Phone (763) 494-4100 +44 (0) 1 869-323-220
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